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Introduction

About This Manual
This manual applies to version GA Rel. 1.1 release of the Imecom FlowVox™ Server/Client
solution. This manual contains FlowVox system information and operation procedures.

Copyright Notice

© 2015 IMECOM GROUP, Inc. All rights reserved. No part of this document may be
reproduced, transmitted, transcribed, or translated into any language in any form by any
means without the written permission of Imecom Group, Inc.

Imecom, the Imecom logo, FlowVox, Use it, Use it Suite, Use it Messaging, DM, DM Server,
DM Fax Server, DM Controller, DM Processing Unit, DM Fax Gateway are registered
trademarks of Imecom Group, Inc. and Prologue Software Group.

All other company, brand and product names are the property, trademarks, or registered
trademarks of their respective holders.

The information contained in this document is subject to change without prior notice.
Unless expressly stated to the contrary, the companies, names and data used in the
examples are purely fictitious.

For More Information

Since 1989, Imecom Group has been providing enterprise fax server solutions, network fax
software, and image printer driver software to companies of all sizes across the world. In
2013 we widened our product suite to include a unified messaging platform, FlowVox. For
more information on Imecom Group and our product offerings, please visit

http://www.imecominc.com and http://www.flowvox.com or call us at +1 603.569.0600.

Imecom Group, Inc.
8 Governor Wentworth Highway
Wolfeboro, NH 03894
U.S.A.

Phone: 603.569.0600
Fax: 603.569.0609

http://www.imecominc.com
http://www.flowvox.com

http://www.imecominc.com
http://www.flowvox.com
http://www.imecominc.com
http://www.flowvox.com
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About FlowVox

FlowVox by IMECOM is a Java- based Server/Client solution that provides users an easy-
to-use interface for managing phone calls via the Open Source Asterisk platform.

The FlowVox Server resides on a highly available computer system within a company's
network and connects to the Asterisk PBX. The FlowVox Client interfaces with the
FlowVox Server and offers a multi-functional, user-friendly and intuitive graphical user
interface. Administrative setup and configuration is easily performed via the FlowVox Client
interface with administrative privileges.

FlowVox allows users to make, receive, park, transfer, and conference calls with simple,
smooth drag-and-drop or right-click mouse actions. FlowVox also includes a voice mail
component that enables user to manage voice mails via the FlowVox Client interface and
listen to voice mail messages using existing computer speakers or a traditional desk phone
handset. FlowVox increases user productivity through a unified communication approach,
which will be functionally expanded in subsequent releases.

The user interface also allows the user to change settings, i.e. presence status indicators
and window docking behavior to their personal preferences.

Figure 1: Diagram of typical FlowVox network set-up
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User Concepts in FlowVox
There are several user concepts to consider when setting up your FlowVox environment. 

1. FlowVox Administrator – This is the default user role that is pre-configured on every
FlowVox system. This administrator does not consume a Client Access License (CAL).

2. FlowVox User - The FlowVox Administrator is responsible for creating and configuring
FlowVox Users and associating FlowVox Users with Asterisk extensions. The number of
FlowVox Users does not impact the Client Access License (CAL). Rather, each
simultaneous connection between a FlowVox Client and a FlowVox Server consumes one
CAL.

3. Asterisk Manager Interface user (AMI user) - This user supplies the credentials needed
to connect the FlowVox Server to the Asterisk Server.

4. Asterisk/FreePBX/Elastix Administrator - This user role is used to access the PBX
management portal. It is not used by FlowVox and should not be mistaken for the AMI
user account.

Figure 2: FlowVox user roles vs. AMI user set-up on the PBX and portals
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FlowVox Feature Overview

FlowVox comes with a rich feature set. This section provides an overview of the main
features. Additional details on possible configuration requirements can be found in the
configuration chapter

Active Call Area

View and control your active calls from this central area of the FlowVox Client. Hang up,
transfer, park and send calls to voicemail, view remote party information, call duration and
more. See "Active Call Area"

Call Logs

FlowVox stores all inbound and outbound call activity in an interactive call log. From the
log, you can perform redial and call back functions with one click of the mouse. See "Call
Log Tab"

Call Parking

Park calls and retrieve parked calls quickly. Park a call simply by dragging it to an open
parking spot or clicking the “Park Call” button from the Active Call Area. Pick-up a parked
call by dragging it to your extension. See "Call Parking and Retrieval"

Call Transfer

Transfer an active call to another extension, conference room, parking spot or voicemail
by dragging the call to the destination or by clicking the transfer button from the Active
Call Area. See "Transfering a Call"

Chat

FlowVox has a build in Jabber-based Chat solution. Every configured user on a FlowVox
Server can use the Chat feature when logged into a FlowVox Client. See "Chat"

Conference Calls

Start conference calls by dragging extensions or active calls into an available conference
room. Need to invite attendees on the fly? Just drag their extension into the conference
room.

The conferencing feature requires conferencing to be enabled on the Asterisk system. The
configured conference rooms are discovered by the FlowVox Server upon startup.

Drag and Drop

Control calls and call operations with one fluid motion. Initiate, transfer and park calls,
start audio conferences, send calls to voicemail, and more with one flick of the mouse.

Docking

The FlowVox Client user interface features a window docking system that allows users to
arrange the UI according to individual preference. Show/hide and dock/undock windows as
needed. See "Docking Feature"

Extension Discovery

Asterisk extensions are automatically discovered by the FlowVox Server upon startup.
Once the FlowVox Server is running, FlowVox users can be imported or created, and
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Asterisk extensions can then be assigned. See "Assigning Extensions"

Feature Codes

FlowVox version 1.1 FlowVox introduces support for Feature Codes. Currently, the Day/
Night toggle feature code has been implemented by default for new FlowVox Server
installations.

FreePBX Portal Integration

FlowVox version 1.1 introduces a new Administration Portal snap-in for FreePBX. Currently,
no snap-in is available for Elastix.

Functional Layout

The main FlowVox Client interface is clean and functional, giving you everything you need
to streamline call management in one place. For those who want a custom user
experience, FlowVox Client windows can be shown/hidden and arranged via docking
options in any layout that works best for the user. See "Docking Feature"

Groups

The Groups feature allows a FlowVox administrator to create Groups. Once the Groups are
created, Users can be added to them. A User can be a member of more than one Group or
can be unassigned as well. Adding or removing users to or from Groups does not require a
FlowVox Client restart to update the UI. See "Creating Groups and Applying Users"

Parking
Parking Slots are discovered by the FlowVox Server from the Asterisk system at start-up.

See "Call Parking and Retrieval"

Queues
The Queuing feature requires Queues to be set-up on the Asterisk system. Configured

Queues are automatically discovered by the FlowVox Server on start-up. Through the

Administration Control Panel, Queue Permissions can be given to configured users on the

FlowVox system. Changes to Queue Permissions require the FlowVox Client to be restarted

in order to be recognized. With FlowVox version 1.1, support for pausing and Agent log-in/

log-out for dynamic queues has been added. See "Queues"

Visual Status

The user status can be set to specific status indicators showing availability setting to
other FlowVox users.

FlowVox allows you to customize visual status indicators that are sent from the server, so
that you can see which lines, extensions, parking spots and conference rooms are
available at one quick glance.

Voicemail

See the number of voicemail messages you have in real time right from the main FlowVox
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Client interface. Listen to your voicemail messages through your computer speakers, your
headset, or your desk phone handset.

Voicemail support in FlowVox utilizes ARI. ARI is a voicemail/recording utility that comes
with AMP. ARI needs to be configured in order for voicemail to function correctly in
FlowVox. See "Asterisk PBX Configuration"
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Requirements

This section contains the following topics:

See "FlowVox Server Platform System Requirements"

See "Client System Requirements"

See "Setting up the Java Environment"

See "Asterisk PBX Configuration"

Elastix Interoperability
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FlowVox Server Platform System Requirements

The FlowVox Server should be installed on a highly available computer system within the
company's secure network. The computer's firewall needs to be configured to allow traffic
on communication ports (6785, 6789, 2221). The FlowVox Server needs to be able to
access the Internet for licensing.

The FlowVox Server at a minimum should be an x86 or x64 Intel Pentium compatible
Computer with

a 1.5 GHz Processor (quad core),

4 GB of RAM (Microsoft Server 2012 8 GB is recommended),

500 GB hard-drive,

Network adapter for Internet access, and

Daily back-up services are recommended.

No other hardware is required for the initial set-up of the FlowVox Server.

Table 1: Minimum Version Overview

JAVA Oracle JDK/JRE 1.7 or higher (http://java.com/en/
download/index.jsp)

Open JDK

Operating System Linux CentOS

Linux Ubuntu

RedHat

Windows Server 2003

Windows 7

Telephony Interface Asterisk PBX 1.8 or higher

http://java.com/en/download/index.jsp
http://java.com/en/download/index.jsp
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Client System Requirements

A desktop or laptop computer running Windows, Mac OS X or Linux. The system memory
should be based on manufacturer recommendations and not minimum requirements by
Microsoft or Apple.

Java VM (http://java.com/en/download/index.jsp) has to be installed on the client

platform.

Microsoft Windows Windows 7, 8

Mac OS X 10.7, 10.8, 10.9

Linux RedHat, Ubuntu or CentOS

Client users will need to have access to SIP Phones, which need to be connected over the
LAN or WiFi.

http://java.com/en/download/index.jsp
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Setting up the Java Environment

The FlowVox Server/Client solution is Java-based. Please ensure that the Java
environment is configured correctly for your operating system to ensure proper operation
of FlowVox.

Windows: JAVA_HOME Environment Variable

Verify that the Java environment is configured properly on each system serving as a
FlowVox Server or hosting a FlowVox Client.

1.Go to Control Panel\System and Security\System

2.Select Advanced System Settings in the left frame.

3.Click the Environment Variables button.
You should have an entry similar to the highlighted JAVA_HOME variable in the
screen shot below:

If the JAVA_HOME variable is not present, create it by clicking the New button and
specifying the path to your Java installation directory.

Linux: PATH and JAVA_HOME System Variable

Verify that the PATH is set correctly for you JAVA package:

set PATH=${PATH}:/home/opt/jdk1.7.0_25/bin

Verify JAVA_HOME, which needs to be exported to be referred to from any shell script:

export JAVA_HOME=/opt/java/jdk_1.7

export PATH= ${PATH}:{JAVA_HOME}/bin

Mac OS X: JDK/JRE

On Mac OS X-based systems, JAVA is configured to the correct PATH and variables upon
installation. To verify that JAVA is installed, open a terminal window and type JAVA -
version.
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AsteriskPBX Configuration

The FlowVox Server/Client Solution interfaces with an Asterisk PBX. For basic installation
and configuration of your Asterisk PBX refer to your Asterisk documentation.

As part of most Host applications that provide an interface to the Asterisk system (like
FreePBX, TrixBox, etc.), the Asterisk Management System needs to be utilized to enable
and run the Asterisk Recording Interface (ARI) and MeetMe application. Asterisk
configuration flags need to be enabled so that features  work correctly with FlowVox. The
following highlights specific configuration settings required for proper operation with the
FlowVox system.

Setting up the Asterisk PBX AMI Manager
1. Log in to your Asterisk system.

2.Setup an AMI Manager user. This user supplies the credentials needed to connect the
FlowVox Server to the Asterisk Server. The API Manager's credential needs to match
the information used later when installing and configuring the FlowVox Server.
("FlowVox" as manager name in screen shot below is just an example.)
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FreePBX
1. In the FreePBX portal, navigate to the Add Manager screen (Admin->Settings->Asterisk

Manager Users). 

2. For Manager Name enter FlowVox (or the name you want to use during the installation)

3. For Manager Secret enter the "secret" for your FlowVox system (needed later for the
installation).

4. Select to Deny no one, Permit all and Read/Write all (you can always adjust these
settings a later).
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Elastix
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1. In the Elastix interface navigate to PBX.

2. Select the Arrow on Security and go to Advanced Settings.

3. Enable direct access "ON".

4.On the PBX tab under Options select on the bottom "Unembedded FreePBX" ->
FreePBX. 

MeetMe Conferencing

MeetMe is used for FlowVox Client conferencing support. The MeetMe application MUST be
selected to manage conferencing properly. If this application has not been enabled during
the initial installation and setup of the PBX, it can be enabled later via the PBX
Administration UI under Advanced Settings.

Enable ARI on FreePBX
ARI is used for the FlowVox Client voicemail support. ARI is a voicemail/recording utility
that comes with AMP. 

To support playing recordings, such as voicemail and other .wav files to extensions, the
ARI Framework is required for both FlowVox and the FreePBX User Portal.

By default the ARI Framework is not enabled in a FreePBX installation. The following steps
show how to enable ARI in the FreePBX from the Web interface (logged in as admin):

1. Select Admin -> Module Admin

2.Select "Basic" repository

3.Click the "Check Online" button. 

4. In the Admin section of the listed modules, locate "FreePBX ARI Framework". This needs
to be "Enabled" but is likely marked as "Disabled". Select to Update & Enable.

5. Select "Process" to enable the ARI Framework after downloading the latest version.

6. The ARI Framework will show as "Enabled" when it is running.

7. Click the red "Apply Config" button to apply the configuration update to the Asterisk
server.

Enable CDR on Asterisk PBX
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In order to properly see the call records, call records must be enabled on the Asterisk PBX.
Look for the following files and set to matching values:

cdr_manager.conf:

[general]
enabled=yes

cdr.conf:

[general]
enabled=yes

Asterisk Configuration Files polled by FlowVox

FlowVox uses many of the Asterisk configuration files and their default values. Screen
shots and examples might differ based on these defaults and your actual site
configuration. For example, FlowVox uses the Asterisk default setting for parking positions,
in this case eight (8) positions numbered 71 through 78. Your specific site configuration
might differ from this.

The following configuration files are polled by FlowVox. The FlowVox Server looks for these
files in their respective default installation directories.

/etc/asterisk/sip.conf

/etc/asterisk/sip_general_additional.conf

/etc/asterisk/sip_general_custom.conf

/etc/asterisk/sip_nat.conf

/etc/asterisk/sip_registrations_custom.conf

/etc/asterisk/sip_registrations.conf

/etc/asterisk/sip_custom.conf

/etc/asterisk/sip_additional.conf

/etc/asterisk/sip_custom_post.conf

/etc/asterisk/voicemail.conf

/etc/asterisk/meetme.conf

Port Configuration

Asterisk PBX to FlowVox Server

The following ports must be enabled for proper communication between the Asterisk PBX
and the FlowVox Server (use 0.0.0.0/0 as source for all to allow any IP addresses to
access the PBX):

5038 (AMI)
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21 (FTP)

FlowVox Server to FlowVox Client

6789 (Events)

6785 (Chat)

2221 (FTP)

50000-60000 (FTP Data)
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freePBX Configuration

NOTE: The FreePBX module is NOT compatible with Elastix.

To install the FlowVox FreePBX module for your environment follow these steps

1.  Enter the Module Administration area. 

2.  Select Upload Modules.

3.  Select FlowVox. For Action select Install.

4.  Click the Process button. 

FreePBX FlowVox Settings
Refer to the following screen capture for sample information relating to FreePBX FlowVox
settings:
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Note: Make sure to specify the correct server port for your environment. The port shown
above is the default port for FlowVox. 

FreePBX Extensions Set-up
Under FlowVox Profile Settings extensions/users can be added manually.

Elastix Interoperability

FlowVox has been designed and tested to operate within an Elastix environment. To
ensure full connectivity, the HTTPS port needs to be opened and set to the correct value.
The default port is 443, but might be different in your system based on prior
specifications.
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Installation Overview

When deploying FlowVox by Imecom the following general steps should be followed. 

1. Install the FlowVox Server software on a highly available networked computer within the
company's corporate network, providing all required information to point to the Asterisk
server and API Manager User account. The installation package is a self-installing,
minimal user action installation package that uses the system default program directory
structure for the installation.

2. Start the FlowVox Server.

3. Install the FlowVox Client software on another networked computer (for Admin/IT
purposes the client may be installed on the same machine acting as the FlowVox
Server).

4. Log-in to the FlowVox Client  as the default administrator user. The default username/
password for the administrator user is: admin/admin

o Enter the FlowVox Server IP address (localhost if installed on same machine as

FlowVox Server for Admin/IT purposes only).

o Verify the Asterisk FTP data port range is set to 50000-60000.

o Verify the Server socket port 6789.

o Verify the Server FTP port 2221.

o Verify the Chat port is 6785.

o Change the admin password via the File/Settings menu.

o Add the users, that require access to the FlowVox Server.

o Assign Extensions to configured users.

5. Install FlowVox Client software on the end user computers.
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Language Selection

FlowVox offers multiple language options for the client user interface. The default
interface language is English. Spanish and French may be selected during the installation
process. This can also be changed post installation via a FlowVox client.

During the FlowVox Server and Client installation, the following prompt will be displayed:

Use the drop-down list box to select the preferred language setting.

Note: The documentation provided with FlowVox is available in English only. Localization of
the documentation will be available in future releases.
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User Account Control (UAC)

When installing FlowVox Server and Client software, a User Account Control prompt is
opened. Install the FlowVox software only when the prompt contains "Imecom Group, Inc."
as a verified publisher.



© 2015 Imecom Group, Inc Page 27

Linux: FlowVox Server Installation

It is recommended to run the FlowVox Server as a service on Linux systems. The following
is a CLI session output example of installing and starting the FlowVox Server on Linux
(CentOS).

1.Browse to the installation location

Command: cd //opt

2.Download the FlowVox Server installation package. Note: the download URL is specific
to 32-bit and 64-bit versions of Linux.

Command: wget http://www.flowvox.com/trials/current/FlowVoxServerSetup-
x64.run

3.Change the permissions on the downloaded file to allow installation. Note, the example
uses the x64 system version.

Command: chmod 777 http://www.flowvox.com/trials/current/
FlowVoxServerSetup-x64.run

4. Install the FlowVox Server and proceed through the installation prompts. Refer to
sample CLI output:

Command: http://www.flowvox.com/trials/current/FlowVoxServerSetup-x64.run

[root@localhost opt]# http://www.flowvox.com/trials/current/
FlowVoxServerSetup-x64.run

Language Selection

Please select the installation language

[1] English - English

[2] Spanish - Espanol

[3] French - Fransais

Please choose an option [1] :

----------------------------------------------------------------------------

Welcome to the FlowVoxServer Setup Wizard.

----------------------------------------------------------------------------

Please read the following License Agreement. You must accept the terms of this

agreement before continuing with the installation.

Press [Enter] to continue :

FLOWVOX END USER LICENSE AGREEMENT

This End User License Agreement is a legal agreement between Imecom Group,
Inc.

(hereinafter " Imecom" ) and you (either an individual or entity) (hereinafter...

....AND BENEFIT THAT RESELLER.
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Press [Enter] to continue :

1. DEFINITIONS...

...certified mail, postage prepaid, to the address as specified in writing by either
party.

Press [Enter] to continue :

Do you accept this license? [y/n]: y

----------------------------------------------------------------------------

Please specify the directory where FlowVoxServer will be installed.

Installation Directory [/opt/FlowVoxServer]:

----------------------------------------------------------------------------

Asterisk Server IP []: your Asterisk IP

Asterisk FTP Data Port [50000-60000]:

FlowVox Server Port [6789]:

FlowVox FTP Port [2221]:

Asterisk Manager Username []: your Asterisk Manager Username

Asterisk Manager Password []: your Asterisk Manager Password

NOTE: The Asterisk Manager account refers to the AMI account, NOT the
account used to access the PBX Admin Portal.

----------------------------------------------------------------------------

Asterisk Manager User and FlowVox License

FlowVox License []: your FlowVox trial or production license key

License Name []: your license name

Company Name []: your company name

----------------------------------------------------------------------------

Setup is now ready to begin installing FlowVoxServer on your computer.

Do you want to continue? [Y/n]: y

Please wait while setup installs FlowVoxServer on your computer.

Installing

0%_______50%_______100%

###################

----------------------------------------------------------------------------

Setup has finished installing FlowVoxServer on your computer.

Install and Run as Linux Service [Y/n]: y

The FlowVox Server Service will be installed and started automatically after you confirm
the previous prompt with y (yes).
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Windows: FlowVox Server Installation

Download the installation package at:

http://www.flowvox.com/trials/current/FlowVoxServerSetup.exe

After downloading the FlowVox Server installation package from the website, launch the
setup executable.

1.Select your preferred system language.

Click the OK button to proceed.

2. The Setup dialog for the FlowVox Server opens as shown below. Click the Next button
to proceed.

http://www.imecominc.com/flowvox/trials/current/FlowVoxClientSetup.exe
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3.

4. The FlowVox End User License Agreement dialog opens. Accept the agreement and click
Next to continue with the installation process. Failing to agree with the License
Agreement will terminate installation.
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5. The default installation directory for FlowVox will be displayed. It is recommened to use
the default installation directory. Click Next.
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6. The Asterisk Server Information dialog opens:

a. Enter the IP address of the Asterisk PBX

b.Do not change the pre-existing port settings.

c. Enter the Asterisk Manager Username as established on the Asterisk PBX.

d. Enter the Asterisk Manager Password as established on the Asterisk PBX.
NOTE: The Asterisk Manager account refers to the AMI account, NOT the
account used to access the PBX Admin Portal.

e.Click Next.

5. In the Asterisk Manager User and FlowVox License dialog enter the license information
supplied by Imecom.
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a. Enter the license key.

b. Enter the License Name.

c. Enter the Company Name.

d.Click Next.

6.  Confirm and start the installation by clicking Next.
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7.Once the installation is completed you will see the Completing the FlowVox Server Setup
Wizard dialog. By default the Install and Run as Windows Service option is selected. If
this installation is on a production system, it is recommended to run the FlowVox Server
as a service. Click the Finish button to close the dialog.
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You are now ready to start the FlowVox Server application.

See "Running FlowVox Server as an Application"



© 2015 Imecom Group, IncPage 36

Post Installation Administrative Steps

1. Install the FlowVox Client on another networked computer.
Note: For Admin/IT purposes, the FlowVox client may be installed on the same
machine acting as the FlowVox Server, pointing to localhost under Server IP
address in the log-in screen.

2.Start the FlowVox Client,

3. add Users and 

4. associate Asterisk extensions to FlowVox users.
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Windows: FlowVox Client Installation

Download the installation package at:

http://www.flowvox.com/trials/current/FlowVoxClientSetup.exe

After downloading the FlowVox Client installation package, launch setup executable.

1.Select your preferred system language:

Click OK.

2. The FlowVox Client installation Wizard opens. Click Next to proceed with the installation.

3. The FlowVox End User License Agreement dialog opens. Accept the agreement and click
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Next to continue with the installation process. Failing to agree with the License
Agreement will terminate the installation.

4. The default installation directory for FlowVox will be displayed. It is recommended to use
the default installation directory. Click Next.
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5. The Ready to Install dialog opens. Click Next to proceed with the installation.

6. The Installing dialog opens. This is a status screen for the installation process. If the
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installation wizard discovers a previously installed version of the FlowVox Client, it will
uninstall the previous version and perform an upgrade.

7.Once the installation has completed, you will see the Completing the FlowVoxClient
Setup Wizard dialog. Click Finish.
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You have successfully installed the FlowVox Client software.

To start the FlowVox Client application, See "Windows: Starting the FlowVox Client"
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Mac OSx: FlowVox Client Installation

Starting the Installation

Download the installation package at:

http://www.flowvox.com/trials/current/FlowVoxClientSetup-osx.app.zip

After the download, extract the installation package and launch the installation setup
wizard.

MacOS Client Installation Dialogs

1.Select your preferred system language and Click OK.

2. The Setup dialog for the FlowVox Client opens as shown below. Click Next.

3. The FlowVox End User License Agreement opens. Accept the agreement and click Next
to continue the installation process. Failing to agree with the License Agreement will
terminate installation.
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4. The default installation directory for FlowVox will be displayed. It is recommended to use
the defalt installation directory. Click  Next.

5. The Ready to Install dialog opens. Click Next to start the installation.
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6.Once the installation is completed you will see the Completing the FlowVoxClient Setup
Wizard dialog. Click Finish.

You are now ready to start the FlowVox Client:

See "Mac OSx: Starting the FlowVox Client"
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Connecting a Client

Port Configuration

To be able to communicate with the FlowVox Enterpriser Server, the following

communication port configuration must be completed on the computer hosting the

FlowVox Client application. Port may be entered via the FlowVox Client login dialog.

Protocol Port: Proprietary 6785, 6789; HTTP 80; FTP 2221
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Starting FlowVox

On Windows and Linux platforms, the FlowVox Server may be installed and run as a
service. This is the recommended method of running FlowVox Server on a production
system.

Service Matrix:

Platform Running as a Service Running as an Application

Windows/FlowVox Server Yes - default option on
installation

Not recommended in
production environment

Windows/FlowVox Client No Yes

Linux/FlowVox Server Yes - default option on
installation

Not recommended in
production environment

Linux/FlowVox Client No Yes - GUI required

Mac OSx/FlowVox Server No Yes

Mac OSx/FlowVox Client No Yes

Refer to the following topics for detailed instructions on starting the FlowVox Server and
Client:

Windows

o FlowVox Server, See "Windows: Running FlowVox Server as a Service"

o FlowVox Client, See "Windows: Starting the FlowVox Client"

Linux:

o FlowVox Server,See "Linux: FlowVox Server Installation"

Mac OSx:

o FlowVox Client, See "Mac OSx: Starting the FlowVox Client"
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Windows: Running FV Server as a Service

Installing and Starting the Service

It is recommended to run the FlowVox Server as a service to prevent downtime after
system restarts. Please follow the steps below to enable this feature for your FlowVox
Server.

1.Open a Command Prompt window.

2.Navigate to the FlowVox Server installation directory. By default:

Application/FlowVoxServer

3. Install the Server service by executing the installation batch file:

installWinService.bat

Starting and Stopping the Service

Use the Task Manager interface to manually start and stop the FlowVox Server Service.

Verify the current state of the FlowVoxServer Service by selecting the Services tab in
Task Manager. To change the status, select the Services... button to open Services
window.
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Scroll down and select the FlowVox Server Service. Depending on the state of the
service, either Start or Stop the service by clicking on the available action in the
Extended tab.

Uninstalling the Service

To remove this feature, execute the uninstallWinService.bat batch file.
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Windows: Starting the FlowVox Client

The installation package automatically creates a short cut to the FlowVox Client
application on the desktop. To launch the FlowVox Client as an application, double-click
the FlowVox Client shortcut. Alternately, FlowVox Client can be launched from the
Windows Start Menu.

The FlowVox Client application shortcut can also be placed in the Start Up folder. Placing
the application shortcut in the Start Up folder ensures that the FlowVox Client is
automatically launched when the system starts and the user logs in. Follow these steps to
place the shortcut into the Start Up folder:

1.Make a copy of the FlowVox Client application shortcut located on your desktop.

2. Click the Windows Start button.

3. Select All Programs.

4.Open the Start Up folder.

5. Paste the FlowVox Client shortcut into the Start Up folder.

The FlowVox Client will now start when the user successfully logs-in to the Windows
system.
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Mac OSx: Starting the FlowVox Client

Using an Application icon

Use the Finder interface to open your FlowVox Client installation directory. In the
directory, click the FlowVox application file.

The FlowVox Client starts.

To automatically start the FlowVox Client when the user logs in, place the application icon
on the application dock. Right click the icon and click Options -> Open at Login.

Using a Terminal window

Follow the command sequence below to start the FlowVox Client application via a terminal
window:

1.Use the change directory command (cd) to access Applications\FlowVoxClient directory.

2. Change the permissions on the directory to administrative rights with chmod 777 *

3.Start the FlowVox Client by typing java -jar commControllerClient.jar
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Running FlowVox Server as an Application

On Mac OSx and Windows operating systems, the FlowVox Server can run as an
application. The following topics explain how to start the FlowVox Server as an
application.

NOTE: FlowVox may be run as an application in lieu of running it as a service. If you
prefer to run FlowVox as a service, you may skip this section.

Mac OSx

On Mac OSx systems this is the only recommended method of running the FlowVox Server.
Running the FlowVox Server as a service is not supported.

Using an Application icon

Use the Finder interface to open your FlowVox Server installation directory. In the
directory, click the FlowVox application file. The FlowVox Server starts.

To automatically start the FlowVox Server when the user logs in, place the application
icon on the application dock. Right click the icon and click Options -> Open at Login.

Using a Terminal window

Follow the command sequence below to start the FlowVox Server application via a
terminal window:

1.Use the change directory command (cd) to access Applications\FlowVoxServer-1.0.

2. Change the permissions on the directory to administrative rights with chmod 777 *

3.Start the FlowVox Server by typing java -jar commControllerServer.jar

Windows

The installation package automatically creates a shortcut to the FlowVox Server
application on the desktop. To start the FlowVox Server as an application, double-click
that FlowVox Server shortcut. The FlowVox Server starts in a command prompt window.
This terminal window must remain open in order for FlowVox to continue running. Closing
the terminal window cause the FlowVox Server to shut down. 

The FlowVox Server application shortcut can also be placed in the Start Up folder. Placing
the application shortcut in the Start Up folder ensures that the FlowVox Server is started
when the system starts and the user logs in. Follow these steps to place the shortcut into
the Start Up folder:

1.Make a copy of the FlowVox Server application shortcut located on your desktop.

2. Click the Windows Start button.

3. Select All Programs.

4.Open the Start Up folder.
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5. Paste the FlowVox Server shortcut into the Start Up folder.

The FlowVox Server will now start whenever you login to Windows.
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Administrative Configuration

This section contains topic explaining administrative post installation and configuration
tasks:

See "Client Log-in"

See "Administrator Control Panel"

o See "Adding Users"

o See "Creating Groups and Applying Users"

o See "Queues"

o See "Assigning Extensions"

o See "Asterisk Server Settings"

Enabling Chat
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Client Log-in

Open the FlowVox Client interface via the FlowVox program icon in your start menu. The
FlowVox Client opens up with the Login dialog.

Note: Every FlowVox Client user needs to be configured for authentication before
the FlowVox Client can access the FlowVox Server. The only pre-configured user is
the default administrator user (admin/admin). This Admin role-based user does
not consume a Client Access License (CAL) and cannot perform any client
operational functions,  such as placing calls etc.

Logging into the FlowVox Client:

1. In the top text field, next to the user icon, enter your username.

2. In the middle text field, next to the lock icon, enter your password. At initial login, this
will be an administrator supplied password. Once you are logged in, you can use the
File/Settings menu to change to a private password.

3.On initial log in, click into the empty FlowVox Server IP address field to open the Server
setup dialog:

a. Enter the IP Address of the FlowVox Server. Use localhost if the FlowVox Client and
FlowVox Server resides on same machine (for Admin/IT purposes only).

b. Enter the Server Socket port of 6789, if not already populated.

c. Enter the Server FTP port of 2221, if not already populated.

d. Click Done.
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Note: The substeps above should only be necessary at initial log in. In the case
that multiple FlowVox Servers are used, the Server IP Address may be changed
as desired, the port information from step b and c should not be touched after
initial set up.

4.Click the arrow or press the Enter key on your keyboard to initiate FlowVox Client login.

5. The FlowVox Client opens to the default user panel:

Administrator Control Panel

Use the View/Admin Control Panel menu to open the Administrator Control Panel:
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Administrators use the Administrator Control Panel to

Provision Users. See "Adding Users"

Provision Extensions. See "Assigning Extensions"

Specify logging levels, initiate database exports and refresh the license under
Asterisk Server Settings. See "Asterisk Server Settings"

Create Queues and assign Queue Permissions. See "Queues"

Adding Users

Users can be added to the FlowVox system in two ways, manually or via file import.

If FlowVox is to be set up with an existing Asterisk PBX already carrying live traffic with
users and extensions, importing the users via .csv file is recommended. Extensions are
always automatically discovered by FlowVox, so in instances of a bulk user import,
extensions only need to be assigned to users.

Adding Users via File Import

1.Create a Users2.csv file. This can be done by exporting users from an Asterisk system
into the .csv file format.

2. The file contents should follow the following data format and requires the following
fields:

DisplayName,Username,Password,rolename,canrecord

3. There are two optional fields that may be added - ContantGroup and Photo. Make sure
to follow proper comma separated formatting without spaces.

4. Add the file to the FlowVox Server installation directory into resources/csvFiles.

5. Launch  the FlowVox Client and log-in as a user with administrative rights.
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6.Click on Users, the Users dialog screen opens:

7.Click the Import Users button to open the following dialog:

Enter the file name for the *.csv file to be imported. In our example we used
Users2.csv.

Keep or change the default file handling preferences.

Click the Import button.

8.Once the import is completed, click OK on the confirmation pop-up dialog.

Manually Adding Users
To manually add users to FlowVox.
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1.Open the Administrator Control Panel and click the Users button.

2. Enter a new User Name.

3. Enter a new Display Name.

4. Select the Role for the new user.

5. Specify recording options for the new user.

6. Specify an initial default Password for the new user.

7.With the Add Extension button you can add Extension information for the newly created
user.
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8.Click Done.

Repeat steps 1 through 8 for every new user to be configured in FlowVox.

Creating Groups and Applying Users

Users can be organized in Groups based on operational units/departments within a
business.

Creating Groups

1. From the Administrative Control Panel, click Users.

2. Click the Groups button.
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3.Click the New Group button and enter the Group Name in the dialog box to create a
Group. For this example we added “Helpdesk” as a Group Name.

4.Click Ok. The Helpdesk group now appears in the Groups administrative panel:
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Adding Users to Groups

To add users to groups:

1.Select a group from the groups list.

2. Select a user name from the users list.

3. Click the Apply button.

Removing a Group
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To remove a configured group, select the group from the Groups panel and click Remove
Group.

Queues

Queues are automatically discovered from the Asterisk system. The FlowVox Client allows
for queue management by letting administrators change queue names and assign queue
permissions to users.

Assigning Queue Permissions

Queue Permissions are granted on a per user basis.

1. From the Administrative Control Panel, click Users:

2. Click  Queue Permission.
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3.Select a user name and then select the Queue name to assign the permission.

4. Click Done.

Assigning Extensions

Extensions are automatically discovered from the Asterisk server after the FlowVox Server
establishes a connection. Once a FlowVox User has been created, the Administrator may
then associate an Asterisk Extension with the user and apply user specific rules to the
discovered extension.

  

1. Specify if the Scope is for a Single user or All users.

2. Specify the User if the rule applies to single user.

3. Specify if the rule pertains to a single number or number range.
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4. In the Starting number field enter the first number for the rule.

5. Click Done to save the changes.

Asterisk Server Settings

Asterisk Server Settings encompass Logging, Backups and Licenses.

Logging Level

Under Asterisk Server Settings the administrator can change the logging level via the
Logging Level drop-down menu. The FlowVox Server creates a FlowVoxServer.log file in
the default installation directory.

The amount of information in the log files will differ greatly, based on the debug level set.

The default of 0 will always show errors and unknown events that we get from Asterisk

(likely with different versions). The higher levels may be required at any time to resolve

Asterisk interface issues..
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If any changes were made to log settings, click Done to save the changes.

Database Export

Prior to upgrading a FlowVox Server, it is recommended to export the database. Use the
Export database button to export your data in *.csv file format. The date will be exported
to the following location within the installation directory \resources\csvFiles\Exports.
Move or copy the CSV file to a different location outside the FlowVox installation directory
before initiating the upgrade.

After a successful export, the following confirmation prompt is displayed.

License Refresh and Renewal

Changing the number of Client Access Licenses (CALs) or renewing the license on the
FlowVox Server is a two-step process.

After receiving a new license key from Imecom Group, Inc. the FlowVox system
administrator needs to  update the FlowVoxES.properties files locatedin the FlowVox
Server installation directory.
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In the properties file, locate the license key entry and replace the old license key with the
newly issued license key. Save the changes. Note: If  security settings on your system
prevent you from saving the edited properties file in the FlowVox Server installation
directory, save the edited properties file to another location, i.e. desktop. From there,
copy theback into to the installation directory, overwriting the original one

Launch a FlowVox Client and login with a FlowVox User that has administrative user
privileges. Open the Administrator Control Panel. On the Asterisk Server Settings
screen,click Renew Server License.

A successful license refresh or renewal will show the following confirmation prompt.

Enabling Chat

FlowVox comes with build-in Chat functionality. To use Chat, the following port needs to
be enabled:

6785 (Openfire plain)

This default ports can be customized via the server properties file. However, this is only
recommend for experienced administrators.



© 2015 Imecom Group, Inc Page 67

Client Operations Overview

This chapter contains topics explaining the major features of the FlowVox Client. It also
gives detailed instructions on user operational procedures.

See "FlowVox Client"

See "Menu Bar and Drop-Downs"

See "Settings Menu"

See "Docking Feature"

See "Active Call Area"

See "Contacts Panel"

See "Chat"

See "Voicemail Window"

See "Call Log Tab"

See "Making Calls"

See "Transfering a Call"

See "Call Parking and Retrieval"

See "Queues"

See Feature Codes

FlowVox Client

The FlowVox Client interface allows you to initiate, transfer, park, and conference calls,
view and manage voice mails, and more with fluid drag-and-drop motions.
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The FlowVox Client has four main operational sub-windows that can be opened and
docked to the main panel or undocked and moved based on personal preferences.

My Phones  (number indicates voicemail count)

o Lines

o Voicemail and

o Call Log

FlowVox Contacts 

o Asterisk Extensions 

Parked Calls  

Conference Rooms .

Menu Bar and Drop-Downs

Users can change settings and preferences, and show/hide FlowVox sub-windows.

The File Menu

The following screen capture shows the options under the File drop-down menu:
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Under Settings, the user can edit: 

user preferences and

account settings.

See "Settings Menu"

The View Menu

The View drop down menu offers the following selections:

Windows always on top: if selected, the FlowVox Client GUI stays on top of other
running applications.

Dialer: opens a dialer pad.

Admin Control Panel - opens the Administrator Control Panel (admin privileges required)

My Phones - opens the user's “My Lines”  tab.

Parked Calls opens the Parked Calls tab.

Conference Rooms opens the Conferencing tab.

Extensions opens the Extensions tab.

Contacts opens the contacts/extensions sub-window.

Call Log - opens the Call Log tab.

Voicemail - opens the user’s voicemail tab.

Call Monitor - opens the Call Monitor.

Queues - opens the Queues sub-window.

Feature Codes

Settings Menu

Under Settings users can change preferences and account settings.
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Changing the Password

Users can change their password from the Account Settings tab under Application
Settings.

To change the password, click the Change Password button after selecting Account
Settings.
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Docking Feature

The FlowVox Client provides a docking feature that allows each FlowVox Client user to
dock/undock any sub-window/panel.

Docking and undocking is achieved by clicking in the docking symbol in the top right corner
of each sub-window.

Symbol for a docked window 

Symbol for an undocked window 

When the windows are undocked, the different sub-windows can be re-arranged and
placed anywhere on the viewable display area.

The following screen capture is an example of FlowVox with undocked windows for all
functional areas.
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The windows can be sized by click and drag operation on any of the outside boarders. To
have the wub-windows in a certain order while docked within the main panel, the user
needs to openand dock eachwub-window in order of preference. When docking sub-
windows, it is likely that the main FlowVox Client window will need to be resized from its
default opening height in order to fit the docked sub-windows. FlowVox automatically
saves user preferences so that the layout is preserved for future login.

 

Active Call Area

The Active Call Area of the FlowVox Client serves as the main operation control when a
call is in session.

Users initiate calls, call transfers, call parking, and call termination from this area.

Once a call is in session, the active call area contains details about the call, as shown in
the example screen capture below.

The Active Call Area shows:

The outgoing line - in this case Jane's 404 - as being up for 2 min and 34 seconds.

The extension to which the call is connected - in this case 212
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Possible actions for this call:

o Terminate 

o Transfer 

o Park 

Transfer

If the user clicks the transfer button, a transfer screen will display. On the transfer dialog
screen, select the extension to which the call is to be transferred. It is also possible to
simply drag the active call to an extension on the extension tab to execute a call transfer.

See "Transfering a Call"

Park

If a user clicks the park button, the call will be placed in the first available park slot on the
Asterisk Server. It is also possible to simply drag and drop the active call onto one of the
open park slots on the Call Parking sub-window.

See "Call Parking and Retrieval"

Contacts Panel

The Contacts Panel shows all users configured on the FlowVox system. If Groups have
been created and users have been assigned to those groups, the user names and their
current FlowVox Client presence status is displayed.

The Extensions tab lists all extensions automatically discovered from the Asterisk Server.
NOTE: The status on the Extensions tab indicates the status of the Asterisk Extension
and not the presence status of the FlowVox User. FlowVox User presence status is
displayed on the Contacts tab.
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Chat

FlowVox comes with a build in Jabber-based chat solution.

To initiate a new chat with a FlowVox User, navigate to the Contacts tab and mouse over
the desired FlowVox User. Click the chat symbol that appears to the rightof the user’s
name.
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In the chat window, type you message and click Send. When chatting with multiple
FlowVox Users, each user is listed in the left-hand column of the Chat window. To chat
with a specific user, simply click on the user, type your chat message, and click Send.

 

Voicemail Window

On the My Phones sub-windows, click the Voicemail tab to view all voicemail messages
belonging to the logged in FlowVox User.
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The following screen capture shows available operations via the right-click menu on the
voicemail filesiles:

Play Voicemail

Play Voicemail will download the voicemail file from the server and play the message
through the speakers on your FlowVox Client host machine.

Download Voicemail

Download Voicemail will download the voicemail file from the server only; it will not play
the voicemail message..

Play Voicemail to Handset

Play Voicemail to Handsetwill play the voicemail message via  the primary phone
connected to FlowVox.

Call Log Tab

The Call Log tab shows the a log of call activity for the logged in FlowVox User. The call
log displays most recent activity at the top. From the call log, the user can perform redial
and call-back functions. The following screen capture shows an example call log.
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.

Making Calls

Using the Dialer

1. From the menu bar, click View > Dialer, or click the dialer pad icon in the dial field. The
dialer pad will display to the left of the FlowVox Client interface.

2. Enter the desired number or extension and click the Dial button or press Enter.
If no default outgoing line is selected, FlowVox prompts the user to specify a default
outgoing line before the call is initiated

Drag and Drop
Much of the FlowVox Client interface is drag-and-drop enabled. This allows users to
initiate call activity via a simple drag-and-drop operation within the FlowVox Client UI. The
procedure below illustrates how to initiate a call to an Asterisk Extension using drag-and-
drop.

1. Click your outgoing line from the My Phones panel.

2.Drag the line to the desired Extension on the Extensions tab.
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3.Drop the line to establish the call.

Transfering a Call

Drag and Drop

1.In the My Phones panel, click the line with the active call.

2.Drag the line to the destination Extension on the Extensions tab.

3.Drop the line to transfer the call.

Using Mouse Click Action

Using FlowVox, it is possible to transfer a call to  one of your other phones, an extension,
or to voicemail using a simple mouse click action.

In the active call window click the Transfer  button. 

Select the destination line from the My Phones, Extension from the Extension tab, or click
the To Voicemail button to transfer the call to voicemail.
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Call Parking and Retrieval

To Park a call, simply drag it to an open park slot. Retrieve a parked call by dragging it to
your extension or phone.

Drag and Drop

1.On the My Phones panel, click the line with the active call.

2.Drag the line to an available park slot in the Parked Calls panel.

3.Drop the line on the available park slot to park the call.

Using Mouse Click Action

To park a call, click the park  button from the active call area.

The call is automatically parked in the first open park spot.

Queues

In the Queue Panel, users with queue permissions can view queues and take active calls.
By default, in deployments with dynamic queue configuration, Agents can perform pause
and login/logout for the authorized queues via the toggle button. In systems configured
with static queues, the toggle button does not have any impact. 
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The above screen capture shows that the specific user has permissions for configured
Queue 151 and that the user/agent is currently logged out. 

In order for the user to be an active agent on Queue 151, the user needs to login by
clicking the Logged Out button (to the button will then toggle to a Logged In status). If
this is the first time the agent logs in to the queue, the next screen will display the user’s
lines on the system and ask which of the available lines to associate with the active
queue. The user then needs to select a line and will have the option toset the selected
line as the default for all queue related operations.

The above screen capture shows that the specific user is an active agent on Queue 151.
To log out, click the Logged In button and toggle to a Logged Out status.

 

Feature Codes

FlowVox currently supports the feature code for the Day/Night toggle.

Use the View menu to select Feature Codes from the drop down. Change the setting via
the toggle button to enable/disable the feature.
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Maintenance Overview

This chapter contains topics for system maintenance actions and operations.

Refer to the following topics for details:

See "Upgrading FlowVox"

See "Export Database"

Export Database

The FlowVox Administrator may use the Export Database feature to perform periodic
backups of the existing FlowVox database, and to preserve provisioning data prior to a
FlowVox upgrade.

The following database tables are exported with this feature:

Users

User Roles

Line Groups

Contact Service User Credentials

By default, the export directory is as follows:

"install directory"\resources\csvFiles\exports

Exporting the Database

1. Log in to a FlowVox Client as a user with administrative privileges.

2. Click the View/Administrator Control Panel.

3. Click the Asterisk Server Settings button:



© 2015 Imecom Group, Inc Page 83

4.Click the Export Databases button to export the database table.

The following dialog opens after a successful database export:

5. Acknowledge the completed procedure by clicking OK.

6. You may now exit the Asterisk Server Settings and Administrator Control Panel dialogs.

Upgrading FlowVox

The following steps are recommended when upgrade an existing FlowVox system:

1. Export your existing database. See "Export Database"

2.Use the new FlowVox Server installation package to upgrade your FlowVox Server. See
"Installation Overview"

3.Move your exported database files to the default installation directory of your FlowVox
Server.
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4.Use the new FlowVox Client installation package to upgrade at least one FlowVox Client.

5. Log into the FlowVox Client with administrative privileges and verify that the database
files have initialized correctly.

Follow the linked procedures for detailed instructions on how to perform each upgrade
sequence.
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